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Copyright

Dieses Dokument unterliegt dem Copyright © 2010–2024. Die Beitragenden sind unten aufgeführt. 
Sie dürfen dieses Dokument unter den Bedingungen der GNU General Public License 
(http://www.gnu.org/licenses/gpl.html), Version 3 oder höher oder der Creative Commons Attributi-
on License (https://creativecommons.org/licenses/by/4.0/) Version 4.0 oder höher, verändern 
und/oder weitergeben.

Warennamen werden ohne Gewährleistung der freien Verwendbarkeit benutzt.

Fast alle Hardware- und Softwarebezeichnungen sowie weitere Stichworte und sonstige Angaben, 
die in diesem Buch verwendet werden, sind als eingetragene Marken geschützt.

Da es nicht möglich ist, in allen Fällen zeitnah zu ermitteln, ob ein Markenschutz besteht, wird das 
Symbol (R) in diesem Buch nicht verwendet.

Mitwirkende/Autoren
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Danksagung

An die ganzen Teams der freien Office-Programme insbesondere alle Mitglieder und 
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Rückmeldung

Kommentare oder Vorschläge zu diesem Dokument können Sie in deutscher Sprache an die 
Adresse discuss@de.libreoffice.org senden.

Vorsicht

Alles, was an eine Mailingliste geschickt wird, inklusive der E-Mail-Adresse und 
anderer persönlicher Daten, die die E-Mail enthält, wird öffentlich archiviert und kann 
nicht gelöscht werden. Also, schreiben Sie bitte mit Bedacht!

Datum der Veröffentlichung und Softwareversion

Veröffentlicht am 02.05.2024. Basierend auf der LibreOffice Version 24.2.
Andere Versionen von LibreOffice können sich im Aussehen und der Funktion unterscheiden.

Hinweis

Einige Screenshots und Bilder sind nicht aus Version 24.2, haben aber trotzdem 
Gültigkeit.
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Verwendung von LibreOffice unter macOS

Einige Tastenbelegungen und Menüeinträge unterscheiden sich zwischen der Macintosh-Version 
und denen für Windows- und Linux-Rechner. Die unten stehende Tabelle gibt Ihnen einige grund-
legende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der Hilfe der jeweiligen 
Komponente.

In Windows/Linux entspricht unter macOS Effekt
Menü
Extras > Optionen

LibreOffice > Einstellungen Zugriff auf die Programmoptionen

RECHTSKLICK

CTRL+KLICK und/oder 
RECHTSKLICK je nach 
Einstellungen

Öffnen eines Kontextmenüs

STRG (Steuerung) ⌘ (Command)
Tastenkürzel in Verbindung mit anderen 
Tasten

ALT ⌥ und/oder Alt oder Option
Tastenkürzel in Verbindung mit anderen 
Tasten

F11 ⌘+T
Öffnen der Formatvorlagen in der 
Seitenleiste

Synonyme

In diesem Dokument verwendete Synonyme:

für

Abschnitt

Deck

Dialogfeld, Dialogbox

Dropdown-

Anfasser (Punkte am Ende einer Symbolleiste)

Menüleiste, Hauptmenü,

Popup-Menü

Register, Reiter

Tabulator

Objektpunkte (quadratisch, rund, oval)

in diesem Dokument verwendet

Bereich

Bereich

Dialog

Auswahl-

Griff(e)

Menü

Menü

Tab

Tabulator

Ziehpunkte

Viele Begriffe im Bezug zu LibreOffice und den darin verwendeten Techniken finden Sie im 
Glossar. Das Handbuch Glossar wurde für alle Komponenten von LibreOffice erstellt und kann im 
Bereich „Erste Schritte‟ ganz unten herunter geladen werden.

Sie sehen vielleicht etwas anderes

LibreOffice läuft auf Windows, Linux, Mac OS X, FreeBSD und anderen Unix-Varianten, von 
denen jedes Betriebssystem unterschiedliche Versionen hat und kann von den Nutzern bezüglich 
Schriftarten, Farben und Themen angepasst werden.

Die Bilder in diesem Handbuch wurden mit hellem Thema in Windows 10 erstellt. Das LibreOffice 
Thema entspricht der Werkseinstellungen.
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Über dieses Dokument

Diese Anleitung soll Sie dazu bringen Installationspläne schnell, effektiv und wiederholbar zu 
Dokumentationszwecken zu erstellen. Mit den gezeigten Schritten kann das für den 
elektrotechnischen Bereich gelingen. Durch Anwendung der hier beschriebenen Techniken ist eine 
Umsetzung anderer technischer Zeichnungen möglich. Dieses Dokument stellt keinen Anspruch 
auf Vollständigkeit.

In dieser Kurzanleitung werden die grundsätzliche Kenntnisse bei der Bedienung des Computers 
und auch der LibreOffice Programme – speziell des Teiles LibreOffice Draw – vorausgesetzt. Eine 
einfache Zeichnung und die Grundfunktionen sollten Sie beherrschen. Im Zweifel schauen Sie 
bitte im LibreOffice Draw Handbuch nach. Älter Abbildungen des Installationsplanes stammen aus 
der LibreOffice Version 4.1.

Das Thema im TDF-Wiki1: 
https://wiki.documentfoundation.org/Videos/Electrical_installation_plans/de

Grundsätzliches

Wozu benötigt man Installationspläne?

Verschiedene Gesetze und Verordnungen, wie beispielsweise VOB und VDE, fordern von 
Auftragnehmern und Auftraggebern von Bauten in Deutschland und auch in Europa die 
Dokumentation der erstellten Gewerke.

Hinweis

Beachten Sie hierzu bei Interesse:

VOB Teil B, VOB Teil C (ATV), DIN 18382, DIN VDE 0100-610, DIN VDE 0105-100

Siehe auch: Vereinbarung zwischen Auftraggeber und Auftragnehmer, Seite 39

Installationspläne sind notwendig und sinnvoll

Schon bei der technischen Installation kleiner Anlagen und Anlagenteile ist es sinnvoll 
Installationspläne2 zu erstellen. Diese dienen der eindeutigen Darstellung eines Auftrages und 
helfen somit, Unklarheiten von vorn herein zu minimieren.

Zusätzlich besteht die Notwendigkeit von revidierten Plänen. Das heißt, die Pläne, die Grundlage 
der Auftragsvergabe waren, werden zum Abschluss der Arbeiten an den aktuellen Stand 
angepasst und stellen sodann den tatsächlichen Stand der Installation dar.

Damit wird aus den gegebenenfalls auftretenden Differenzen zwischen den Plänen sofort eine 
bedeutsame Abweichung sichtbar.

Mehr- oder Minderleistungen können dann, neben dem Schriftverkehr für die Vereinbarung 
zwischen Auftraggeber und Auftragnehmer, schnell erkannt werden.

1 TDF = The Document Foundation
2 https://de.wikipedia.org/wiki/Installationsplan
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Technische Unterlagen mit einem Office Programm

Vor- und Nachteile

Technische Unterlagen werden heute in aller Regel mit mehreren Programmen erstellt. Im 
technischen Bereich sind hier vor allem CAD3-Programme aber auch 3D-CAD und Renderer zu 
nennen.

Ab einem gewissen Umfang sind diese auf jeden Fall zu benutzen, da Office-Programme meist 
auf Vielseitigkeit ausgelegt sind und es für große Projekte spezieller Funktionen bedarf.

Nachteile

• Spezialfunktionen sind nur in speziellen Programmen (CAD) vorhanden

• Grafische und textliche Funktionen sind in verschiedene Office Bereiche (Writer, Draw,...) 
verteilt

• für große Projekte nicht nutzbar

• Bauteile-Bibliotheken sind für Office-Formate nicht ohne weiteres verfügbar.

Vorteile

• Das Dokumentenformat ist "offen" (ODF – Format4)

• Die LibreOffice-Suite ist eine "Freie Open Source Software". Sie ist daher frei zum 
Herunterladen, frei im Gebrauch und frei in der Verbreitung.

• Für kleine und mittlere Projekte schnell, flexibel und kostengünstig.

• die Einarbeitung und Schulung ist durch die routinierte Nutzung einer Office-Suite nicht so 
umfangreich

• Für LibreOffice stehen Handbücher, Videos, Hilfe-Seiten, eine Frage-/Antwort-Webseite 
und Wikiseiten mit vielen ausführlichen Informationen zur Verfügung, siehe Weitere 
Informationen auf Seite .36

Minimale Voraussetzungen

Die Fähigkeit Vektorgrafik zu erzeugen

Zur Erstellung von Installationsplänen bedarf es ein paar wichtiger Voraussetzungen. Da die 
resultierenden Pläne in aller Regel grafische Inhalte haben, ist Vektorgrafik5-Fähigkeit das 
oberste Gebot. In der Komponente Draw haben Sie die Möglichkeit vektorbasierte Grafiken zu 
erstellen.

Integration verschiedener Inhalte

Inhalte einer technischen Dokumentation sind in aller Regel in verschiedene Teile gegliedert. 
Beispielsweise Texte, gescannte Vorlagen, Maße, Bauteile, Hinweise (Notizen) und so weiter.

Ebenen

Da viele dieser Inhalte sich möglicherweise auf denselben Teil der Dokumentation beziehen 
können, verdecken sich Informationen unter Umständen gegenseitig.

3 Computer Aided Design
4 ODF= Open Document Format
5 https://de.wikipedia.org/wiki/Vektorgrafik
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Auf einem Gebäudegrundriss in der Draufsicht überdeckt ein Raumtext vielleicht das Zeichen 
der Deckenbeleuchtung.

Eine Gruppierung der Elemente auf einzelne, transparente Seiten, so genannte Ebenen6, die 
sich einzeln sichtbar, druckbar oder sperrbar machen lassen, ist daher unabdingbar.

Unterstützung von verschiedenen Ein- und Ausgabeformaten

Grundlage kann wie schon erwähnt ein Scan oder aber auch eine CAD-Zeichnung sein. BMP, 
JGP, PDF sollten als Scanformate unterstützt werden. DXF oder auch SVG oder SVGZ als 
Vektorgrafikformate können oft von Architekturbüros zur Verfügung gestellt werden.

Die Ausgabe und vor allem auch die Archivierung als ODF, PDF, SVG, PNG oder anderen 
standardisierten und freien Formaten sind sinnvoll. Schön wäre es, wenn auch wieder DXF 
Dateien gespeichert werden könnten. Dies ist vielleicht in einer späteren Libreoffice Version 
der Fall.

Warum LibreOffice

Ganz einfach

Weil es geht.

Alles, oder zumindest das allermeiste, was in diesem Dokument geschrieben ist, kann ohne 
weiteres auch auf LibreOffice angewendet werden.

(Elektro-) Installationspläne

Ausgangssituation ist eine Zeichnungsvorlage

Vom Auftraggeber bekommen Sie (im schlimmsten Fall) eine Zeichnung auf Papier. Heute gibt es 
allerdings meist einen CAD-Plan auf CD, Stick oder per E-Mail. Dadurch entfallen einige 
Arbeitsschritte.

6 Ebenen = Layer
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Abbildung 1: Foto einer Papiervorlage
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Abbildung 2: Scan des gleichen Projektes

Unter Scan versteht man das optomechanische Abtasten einer Vorlage wie beispielsweise eines 
Plans, siehe: https://de.wikipedia.org/wiki/Scanner_(Datenerfassung)

Endsituation

Am Ende steht Ihnen ein digitaler Plan mit verschiedenen Ebenen zur Verfügung. Hier können Sie 
durch ANKLICKEN alles verändern. Schnell lassen sich per Copy&Paste7 weitere Objekte einfügen 
oder auch einzelne Teile löschen.

7 Copy & Paste = Kopieren und Einfügen
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Office-Dokument

Abbildung 3: obere, linke Ecke des Planes als Screenshot

Ein Screenshot ist eine Kopie vom Bildschirm als Datei, beispielsweise im PNG-Format.

Wie sich ein solcher Plan zusammensetzt

In verschieden Ebenen werden jeweils typgleiche Objekte zusammengefasst. Eine Ebene 
entspricht dabei Objekten des gleichen Typs, wie beispielsweise Schalter oder Steckdosen.

Übereinander betrachtet ergeben diese Ebenen den gesamten Plan. Bei mehreren Ebenen, 
können einzelne Ebenen ein- oder ausgeblendet werden.
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Abbildung 4: Drei Ebenen mit Informationen

Das ergibt übereinander dann folgendes Bild.

Abbildung 5: Gesamtansicht der drei  
Ebenen

Es werden also beispielsweise der Grundriss eines Gebäudes, Texte mit den Namen der Räume, 
Schaltzeichen, Maße, Stromkreisnummern (oder andere Notizen) und so weiter übereinander in 
ein Draw-Dokument eingefügt.

Dabei wird darauf geachtet, dass die Teile, die zusammen gehören auch in der selben Ebene 
eingefügt werden.

Der einfachste Ablauf…

Der einfachste Ablauf ist also:

• Scannen eines Originalplanes

• Anpassen der Farben oder Umwandeln in Graustufen

• Öffnen eines neuen Draw-Dokuments

• Einfügen des gescannten Planes in die unterste Ebene der Zeichnung
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• Beschriftungen und Notizen in ein weitere Ebene einfügen. (beispielsweise Texte für die 
Bezeichnung der einzelnen Räume)

• Installationsschaltzeichen auf einer neuen Ebene setzen 

• möglicherweise noch eine Weitere Ebene mit Stromkreisnummern erstellen

• Speichern und Ausdrucken des fertigen Dokumentes

... ist aber nicht der beste Ablauf

Sollte es sich um den ersten und letzten Installationsplan handeln, den Sie erstellen, dann ist das 
oben genannte ein möglicher Arbeitsablauf.

Ausgehend davon, dass in Zukunft weitere Pläne erstellt werden sollen, werden die Symbole, 
Texte, und Ebenen, die eingefügt werden sollen, in jedem Plan, ganz oder teilweise wieder 
auftauchen.

Es sollte also eine Art Bibliothek mit Inhalten entstehen.

Wenn aber nun jede Vorlage, egal wie groß sie ist, einfach als Scan in das Format DIN A4 
verkleinert oder vergrößert wird, dann müssen die Symbole jedes Mal an die gescannte Zeichnung 
angepasst werden.

Hinweis

Was, wenn alle Pläne immer auf DIN A4 gebracht werden?

Handelt es sich ein kleines Haus von 10 x 10 Metern gescannt, und genau auf unser 
DIN A4 Papier vergrößert, dann ist für einen Schalter von 10 cm genau 2 mm Platz 
auf dem Papier. In diesem Fall erstellen Sie alle Symbole für ein Maß von 2 x 2 mm.

Stellen man sich nun ein weiteres Projekt vor, das bearbeitet werden muss. Sagen wir 
mal eine Halle von 25 x 40 Meter und auch diese Zeichnung scannen Sie auf DIN A4. 
Fügen Sie unsere Symbole als 2 x 2 mm Objekte ein, werden sie viel zu groß sein. 
Alle Symbole müssten auf ein Maß von 0,8 x 0,8 mm verkleinert werden. Die Symbole 
wären nicht mehr lesbar, zudem ist das viel Arbeit.

Der einfache Ablauf wird noch um ein paar Kleinigkeiten 
ergänzt

• Scannen eines Originalplanes

• Anpassen der Farben oder Umwandeln in Graustufen (wenn nötig)

• Öffnen eines neuen Draw-Dokuments

• Einstellen des Seitenformates nach den Maßen unseres Projektes und bezogen auf den 
Maßstab 1:100

◦ Sollte also unser kleines Haus mit 10 x 10 Metern gescannt sein, dann wählen Sie 
beispielsweise Seitengröße DIN A4 (was ungefähr 21 x 29 cm entspricht), bei einem 
Maßstab von 1:100 bekommt man so 21 x 29 Meter dargestellt.

◦ Für unsere große Halle mit den Maßen 25 x 40 Metern wird nun die Seitengröße von 
DIN A3 eingestellt (29 x 42 cm) und der Maßstab von 1:100. Damit können Sie im 
Draw-Dokument 29 x 42 Meter darstellen.

• Einfügen des gescannten Planes in die unterste Ebene der Zeichnung
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◦ Sollte die Zeichnung als maßstabgerechtes, glattes (also nicht verzerrtes) Bild 
vorliegen, wird es an den Maßstab angepasst. 

◦ Sollte die Zeichnung schon als digitales (Vektor-) Bild aus einem CAD Programm 
vorliegen, braucht in aller Regel nichts mehr damit gemacht werden, normalerweise 
passt der Maßstab schon.

◦ Im oberen Beispiel trifft das beides nicht zu. Daher dient der Scan nur als Grundlage für 
das komplette Neuzeichnen der Grundrisse.

• Beschriftungen und Notizen in ein weitere Ebene einfügen. (beispielsweise Texte für die 
Bezeichnung der einzelnen Räume)

• Installationsschaltzeichen (die alle im Maßstab 1:100 entworfen sind) auf einer neuen 
Ebene setzen 

• möglicherweise noch eine weitere Ebene mit Stromkreisnummern erstellen

• Speichern und Ausdrucken des fertigen Dokumentes

Ablauf Stück für Stück

Voraussetzung

Es wird vorausgesetzt, dass Sie sich mit der grundsätzlichen Arbeitstechnik von LibreOffice Draw 
auskennen. Viele Funktionen kann man schon mit dem Kontextmenü über die rechte Maustaste 
erreichen. Zudem wird vorausgesetzt, dass das Ziel als ein Installationsplan (vergleiche Seite 10), 
in diesem Fall ein elektrischer Installationsplan, zu verstehen ist.

Vorbereitungen

Vorbereitungen, die eigentlich immer wieder vorkommen und oft nicht mit dem Office-Programm 
gemacht werden, werden ebenfalls ausgeklammert.

Es sollte also als erstes der Originalplan vorliegen (gegebenenfalls als Scan) und ein neues Draw-
Dokument geöffnet sein.

Einstellen des Draw-Dokuments

Das geöffnete Draw-Dokument wird gleich gespeichert. Ein aussagekräftiger Dokumentname hat 
da sicherlich Vorteile. Datei > Speichern unter… (STRG+UMSCHALT+S)

Sie sollten nun das richtige Seitenformat einstellen. Bei einem voreingestellten Maßstab von 1:100 
können Sie sich die Zentimeterangaben für Seitenbreite und - Höhe als Originalbreite und - höhe 
in Metern vorstellen. Auf einem DIN A3 Blatt von 42 cm x 29 cm im Querformat bekommen Sie 
also ein Projekt von 42 x 29 Metern unter. (Sicherlich etwas weniger, da meistens noch ein Rand 
um die Zeichnung laufen soll.)

Ablauf Stück für Stück 14



Abbildung 6: Dialog "Seiteneigenschaften" - Tab "Seite" | Die Seite einrichten

Die Seiteneinstellung erreichen Sie im Menü unter Seite > Seiteneigenschaften…

Für diese Anleitung wird dort zunächst einmal DIN A4 Querformat eingestellt. Alle anderen 
Einstellungen des Dialogs Seiteneigenschaften bleiben in der vorgegebenen Einstellung.

Der Maßstab der Seite(n) wird in den Optionen eingestellt. Diese Einstellung wählen Sie mit 
Extras > Optionen > LibreOffice Draw > Allgemein. In dem Dialog finden Sie den 
Zeichnungsmaßstab und stellen ihn auf 1:100 ein.
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Abbildung 7: Dialog "Optionen - LibreOffice Draw - Allgemein" | Zeichnungsmaßstab einstellen

Tipp

Wenn schon einmal der Dialog Optionen offen ist, dann sollte auch gleich die Option 
Extras > Optionen > LibreOffice Draw > Drucken > [Drucken] von Ausgeblendete 
Seiten abgeschaltet werden.

Vorsicht

Die Einstellungen unter Extras > Optionen… wirken sich auf alle (zukünftigen) 
Zeichnungen aus. Das muss also beim nächsten Dokument, das neu erstellt wird, 
vielleicht wieder rückgängig gemacht werden.

Einfügen neuer Ebenen für das Original

Unten links auf der Arbeitsfläche sehen Sie die einzelnen Tabs für die Ebenen. Standardmäßig 
stehen da die drei Ebenen Layout, Steuerelemente und Maßlinien.

Eine neue Ebene erstellen Sie über das Menü Einfügen > Ebene…

Hinweis

Ein RECHTSKLICK auf einen solchen Ebenen-Tab öffnet das Kontextmenü. Dort führt 
der Punkt Ebene einfügen… ebenfalls zum Ziel

Diese Ebene bekommt den Namen Scan und eine Beschreibung wie: Gescanntes Original des 
Architekten Mustermann Stand 31.12.2012.
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Auf diese Weise wird eine weitere Ebene erstellt. Sie bekommt den Namen weiße Fläche. Diese 
Ebene wird später genutzt, um eine schnelle Möglichkeit zur Darstellung des Gebäudegrundrisses 
zu zeigen.

Haben Sie den Dialog Ebenen einfügen genau betrachtet? Dort kann man gleich einstellen, ob 
eine Ebene sichtbar, druckbar oder gesperrt ist (Abbildung 8).

Abbildung 8: Dialog "Ebene einfügen"

Diese Eigenschaften sind im späteren Verlauf wichtig. Man erreicht diese Einstellungen über das 
Menü Format > Ebene… oder durch RECHTSKLICK auf einen Ebenen-Tab mittels Kontextmenü 
Ebene ändern…

Das gescannte Original in das neue Draw-Dokument bringen.

Nun wird also die Ebene Scan angewählt und im Menü Einfügen > Bild ausgewählt. Im 
erscheinenden Dialog Bild einfügen8 muss die Datei gesucht werden und durch KLICK auf den 
Schaltfläche Öffnen  wird die gescannte Zeichnung in unser neues Dokument in die Ebene Scan 
eingefügt (Abbildung 9).

8 ist der Dateimanager des Betriebssystems
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Abbildung 9: Eingefügtes Bild

Das soeben eingefügte Bild wird durch 8 kleine Quadrate, die Ziehpunkte genannt werden,  an 
den Seiten als aktiviert gekennzeichnet. Wählen Sie die so selektierte Zeichnung zunächst einmal 
ab.

Tipp

Abwählen der Zeichnung
KLICKEN Sie im Arbeitsfenster neben der Zeichnung oder betätigen Sie die Taste ESC.

Nun sollte das eingefügte Bild zunächst einmal skaliert werden. Damit die Dimensionen, zum 
Beispiel die Maße in der Zeichnung, mit den Einstellungen der Seite zusammen passen.

Suchen Sie in Ihrer Zeichnung einen gut sichtbaren Bereich mit einem Ihnen bekannten (oder 
sichtbaren) waagerechten Maß. Türen bieten sich da an, da sie in der Regel Normmaße von 
76 cm oder 88,5 cm haben.

Zoomen9 Sie einen solchen Bereich gegebenenfalls an.

Wählen Sie das Zeichenwerkzeug für eine Maßlinie aus. Sie finden es in der Symbolleiste 
Zeichnung (Abbildung 10) unter dem Funktionen-Symbol für Linien und Linienpitzen, öffnet die 
Symbolleiste Linien und Pfeile (Abbildung 11). Weitere Informationen zur Maßlinie finden Sie im 
Draw Handbuch Kapitel 11 - Fortgeschrittene Zeichentechniken.

Abbildung 10: Symbolleiste "Zeichnung"

9 Zoomfunktionen im Wiki
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Abbildung 11: Symbolleiste "Linien und Pfeile"

Zeichnen Sie nun eine waagerechte Maßlinie. Halten Sie die Taste UMSCHALT beim Zeichnen 
gedrückt, um orthogonale10 Maßlinien zu zeichnen.

Natürlich wird das Maß zunächst einmal nicht mit der Vorlage übereinstimmen. Doch zunächst 
zeichnen Sie eine weitere Maßlinie. Dieses Mal suchen Sie zunächst einen Bereich mit einem 
bekannten oder sichtbaren senkrechten Maß. In aller Regel gibt es auch hier Tür- oder 
Fenstermaße.

Sollte das Zeichenwerkzeug für Maßlinien nicht mehr aktiv sein, wählen Sie es erneut aus. 
Zeichnen Sie eine senkrechte Maßlinie. Halten Sie dabei ebenfalls die Taste UMSCHALT gedrückt, 
damit die Linie ganz senkrecht wird.

Hinweis

Zum Zeitpunkt der Bearbeitung dieser Kurzanleitung besteht eine Fehlfunktion der 
Maßlinie, wenn der Maßwert nicht zwischen den Hilfslinien passt und bearbeitet 
werden muss. Dazu gibt es aber einen Workaround zur Maßlinie.
Fehler siehe: https://bugs.documentfoundation.org/show_bug.cgi?id=97161 und
https://bugs.documentfoundation.org/show_bug.cgi?id=145969

10 Linien in festem Winkel von 0°, 45°, 90°, 180°, usw. zu den Seitenrändern
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Abbildung 12: Maßlinien eingefügt

Jetzt geht es an das Anpassen der Zeichnungsvorlage.

Skalieren dieser Vorlage

Schauen Sie, ob die im vorherigen Abschnitt gesetzten Maßlinien zu groß oder zu klein sind. 
Dementsprechend muss nun das gesamte Dokument vergrößert oder verkleinert werden.

Markieren Sie alle Teile des aktuellen Dokumentes. Im Menü mit Bearbeiten > Alles 
auswählen… oder der Taste STRG+A.

Sie können zunächst versuchen, die Größe mit der Maus anzupassen, indem Sie die markierten 
Ziehpunkte verschieben, bis die Maßlinien mit den Vorgaben der Vorlage übereinstimmen.

Das gelingt allerdings in den seltensten Fällen. Allerdings können Sie so die Maße schon ungefähr 
anpassen.

Wählen Sie nun Format > Position und Größe (Taste F4) oder RECHTE MAUSTASTE Position und 
Größe… und verändern Sie die Werte für Breite und Höhe in Schritten. Fangen Sie mit großen 
Werten an und verkleinern Sie immer mehr, solange, bis die von Ihnen gezeichneten Maßlinien 
genau das Maß anzeigen, das in der Vorlage gegeben ist.

Natürlich können Sie die neuen Maße auch berechnen.

Nach dem Sie Format > Position und Größe ausgewählt haben sehen Sie die tatsächliche 
Größen der angewählten Zeichnung. Angenommen dort steht 1300 cm Breite und 900cm Höhe.
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In Abbildung 12 sehen Sie das die horizontale Maßlinie 93,9cm einem Maß von 88,5 cm 
entsprechen soll. Durch einfachen Dreisatz errechnen Sie nun die neue Breite der Zeichnung.

Abbildung 13: Dreisatz-
berechnung

Und tragen das Ergebnis 1225,24 cm ein (Abbildung 13).

Genauso verfahren Sie mit der Höhe. Aus 900 cm werden 657,18 cm als neue Höhe
(Abbildung 13).

Abbildung 14: Skalierte Zeichnung

Damit ist die Skalierung abgeschlossen. Wählen Sie zunächst die ganze Zeichnung ab. Und dann 
die beiden Maßlinien nacheinander an, um Sie im Anschluss zu löschen.

Nun sollte die gesamte Zeichnung dem Maßstab entsprechen (Abbildung 14). Wenn allerdings, so 
wie in den Beispielbildern oben, der Scan verrutscht oder "wellig" war, dann werden nicht alle 
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Maße passen. Da hilft dann nur, entweder einen neuen Scan zu erstellen oder die Zeichnung 
aufgrund dieser Skalierung ganz neu zu erstellen.

Entfernen von unwichtigen Zeichnungsdetails

Viele Details in der obigen Zeichnung benötigen Sie für einen Installationsplan nicht. Es geht ja 
darum, die Lage und Art der Installation zu zeigen. Somit sind in aller Regel alle Informationen 
außer dem Grundriss unwichtig.

Neben dem Neuzeichnen des Grundrisses, bietet sich noch eine weitere Möglichkeit mittels der 
Ebenen an.

Aktivieren Sie die Ebene weiße Fläche oder legen Sie eine weitere Ebene mit dem Namen an.

Abdecken von Zeichnungsdetails

Jetzt werden alle Zeichnungsdetails mittels Rechtecken überdeckt.

Zeichnen Sie also ein beliebig großes Rechteck in die Ebene "weiße Fläche" (Abbildung 15).

Tipp

Es kann Ihnen passieren, dass Sie aus Versehen die gescannte Vorlage, in der Ebene 
Scan anwählen und verschieben oder anderweitig verändern. Das sollte natürlich 
nicht passieren, da sich alle weiteren Objekte, Maße oder Texte genau auf diese 
Vorlage beziehen. Wählen Sie daher die Ebene mit der Vorlage aus und rufen Sie die 
Funktion Ebene ändern (RECHTE MAUSTASTE auf dem Ebenen-Tab am unteren 
Fensterrand) auf. Ändern Sie die Ebene auf Gesperrt… Damit ist Sie vor 
unbeabsichtigten Änderungen geschützt.
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Abbildung 15: Eingefügtes Rechteck

Dieses Rechteck verschieben Sie nun in eine Ecke eines Raumes. Im Anschluss vergrößern oder 
verkleinern Sie das Rechteck auf die Größe dieses Raumes (Abbildung 16).

Abbildung 16: Links: Rechteck über dem Raum | Rechts: Rechteck angepasst
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Auf diese Art können sie zunächst alle Flächen mit Rechtecken verdecken. Vielleicht gibt es auch 
Flächen in Ihrer Vorlage, die Sie mit Kreisen, Polygonen oder anderen Flächen verdecken 
müssen.

Es spielt jetzt noch keine Rolle, welche Farbe diese Rechtecke haben, wichtig ist, das Sie sie 
sehen können und so anpassen, wie Sie es für Ihr Projekt benötigen.

Nachdem alle Flächen abgedeckt sind, geht es mit der Auswahl einzelner oder aller Rechtecke 
weiter.

In den Beispielbildern werden bewusst einige Flächen (Räume) nicht mit Rechtecken abgedeckt, 
um den Effekt zu verdeutlichen.

Im folgenden sehen Sie, wie das Draw-Dokument nun aussehen kann (Abbildung 17).

Abbildung 17: Alle erforderlichen Flächen sind nun abgedeckt

Wählen Sie nun alle Rechtecke aus. Entweder alle gleichzeitig oder eines nach dem anderen. 
Achten Sie darauf, die im Hintergrund liegende Zeichnung nicht mit auszuwählen. Wenn Sie alle 
Rechtecke ausgewählt haben, setzen Sie die Farbe der Fläche(n) auf weiß und die Farbe der 
Linie(n) ebenfalls auf weiß.

Format > Fläche… Tab Fläche > [Farbe] > [Farben] > [Weiß]

Format > Linie… Tab Linie > [Linieneigenschaften] > [Farbe] > [Weiß]

oder über das Kontextmenü 

RECHTE MAUSTASTE Fläche Tab Fläche > [Farbe] > [Farben] > [Weiß]

RECHTE MAUSTASTE Linie Tab Linie > [Linieneigenschaften] > [Farbe] > [Weiß]

Danach sollten Sie nur noch die freien Bereiche der unteren Ebenen sehen (Abbildung 18). 
Setzen Sie den Status der Ebene mit den Rechtecken ebenfalls auf Gesperrt.
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Abbildung 18: Zeichnung mit abgedeckten Flächen

Wiederherstellen einzelner Details

Durch das Überdecken sind Teile der Vorlage verschwunden, die Sie gegebenenfalls noch 
brauchen. Türen sind so ein Detail. Allerdings macht es sowieso Sinn, diese zu überdecken und 
dann neu zu zeichnen, da sich die Türanschläge im Verlauf der Planung immer noch einmal 
ändern können. Darauf können Sie in dem Installationsplan reagieren und das schnell anpassen.

Zeichen Sie also ggf. mittels der Linienfunktion die Zimmertüren wieder ein.

Beschriften der einzelnen Abschnitte

Einzelne Räume hatten eine Bezeichnung (Abbildung 19). Diese können Sie nun wieder einfügen. 
Das hat den Vorteil, das Sie den Text im weiteren Verlauf beliebig editieren, verändern oder 
verschieben können.

Denken Sie daran auch für diese Texte eine Ebene anzulegen. Beispielsweise eine Ebene 
Raumtexte.
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Abbildung 19: Zeichnung mit wieder hergestellten Details

Speichern Sie dieses Dokument zunächst ab. Der nächste Schritt ist das Einfügen von 
Installationsobjekten.

Installationszeichen erstellen

In dieser Kurzanleitung werden Elektro-Installationszeichen erstellt. Natürlich können Sie auch 
weitere Symbole, Texte oder Funktionen einfügen.

Heizung, Klima, Lüftung, Möbel und weiteres Inventar sind nur ein paar Beispiele.

Sinnvoll und wichtig ist nur, dass alle diese Zeichen im Maßstab zum Grundriss passen.

Die LibreOffice-Galerie

Die Galerie bietet die Möglichkeit, eine Menge Symbole abzulegen und bei Bedarf per Drag&Drop 
einzufügen.

Die Galerie wird hier aus folgenden Gründen nicht genutzt:
• Das Einschalten dieser Funktion verdeckt einen großen Teil der Zeichnung

• viele Einträge in der Galerie machen sie unübersichtlich

• eine vernünftige Beschriftung ist nicht möglich. Das ist bei unbekannten Symbolen nicht 
sehr hilfreich

• eine Sortierung ist (soweit den Autoren bekannt) nicht möglich

All das kann man mit einem separaten Dokument für die Symbole vermeiden.

Auch und gerade in Verbindung mit der Plattform Linux kann man wunderbar mehrere Desktops 
nutzen. Dazu öffnen Sie Ihr Hauptdokument (den Installationsplan) auf Desktop 1 und können 
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dann das Dokument, das die (elektrischen, bzw. technischen) Symbole enthält auf den Desktop 2 
legen und sollten Sie auch noch Möbel oder andere Details einfügen wollen, dann öffnen Sie ein 
Dokument mit entsprechenden Vorlagen auf dem Desktop 3. Das Umschalten zwischen diesen 
Desktops geht in aller Regel mittels einer Tastenkombination, bei Lubuntu beispielsweise 
CTRL+ALT+▲ und ▼ oder mit der Maus im Panel am Bildschirmrand. In Windows verwenden Sie 
die Taskleiste.

Symbole in einem eigenen Dokument

Es ist also durchaus sinnvoll, Symbole in eigenen Dokumenten abzulegen.

Damit Sie verstehen, wie das funktionieren kann, und damit es nicht gleich zu technisch wird, 
erstellen Sie im folgenden doch einmal ein Dokument mit Vorlagen für Möbel.

Öffnen Sie also ein neues Dokument mit exakt den Einstellungen unserer Zeichnung (vergleiche 
Seite 14). Oder öffnen Sie das zuvor gespeicherte Dokument, speichern Sie es unter dem Namen 
Möbel ab und löschen Sie alle Inhalte der Zeichnung.

Achtung

Denken Sie auch an gesperrte und unsichtbare Ebenen!

Ein neues Dokument "Meine Möbel"

Angenommen, Sie wollen ein Bettgestell für ein Doppelbett in Ihren Plan einfügen. Eine kurze 
Recherche ergibt als Länge 2,12 m und Breite 1,85 m.

Fügen Sie also ein Rechteck von 212 x 185 cm in unser Dokument ein (Abbildung 20).

Abbildung 20: Ein Rechteck für ein Bett

Allerdings wird ein Bett (technisch richtig) ein wenig anders dargestellt. Damit man Breite und 
Länge unterscheiden kann fügen Sie noch ein paar Linien ein (Abbildung 21). Das alles auf einer 
eigenen Ebene Möbel. Fügen Sie noch einen aussagekräftigen Namen und gegebenenfalls 
weitere Notizen ein, die zu dem Möbelstück gehören sollen.
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Abbildung 21: Ein Doppelbett

Sie wissen nun aber im Voraus nicht, an welcher Wand das Möbelstück platziert wird. Es ist 
sinnvoll, schon hier in der Vorlage verschiedene Ansichten abzulegen, dann können Sie später 
gleich die richtige Ausrichtung kopieren und einfügen.

Markieren Sie nun alle Teile, die zu diesem Symbol gehören. Und am Besten gruppieren Sie diese 
Objekte. Das geht über das Kontextmenü – RECHTE MAUSTASTE oder mit Ändern > Gruppieren. 
Jetzt legen Sie das Objekt noch 3 mal an und drehen diese jeweils um 90°.

Wählen Sie dazu die Duplizieren-Funktion. Bearbeiten > Vervielfältigen… und stellen Sie dort 
die Anzahl der Kopien auf 3, die Verschiebung der X-Achse größer als die Breite des Objektes – 
unser Objekt ist 212 cm breit, also stellen Sie 220 cm ein, Y-Achse = 0 – und den Drehwinkel auf 
90°.

Nach dem KLICK auf OK  erhalten Sie 3 weitere Betten in einer Reihe (Abbildung 22).

Abbildung 22: Für jede Richtung ein Doppelbett

In einer weiteren Ebene Beschreibung fügen Sie vielleicht noch einen beschreibenden Text ein, 
damit Sie später wissen, welches Bett dies denn genau ist. Diese Ebene setzen Sie in den 
Eigenschaften später auf Gesperrt damit diese Texte nicht mit in Ihre Pläne eingefügt werden.
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Einfügen eines Symbols "Bett" in Ihren Plan

Öffnen Sie also das zuvor gespeicherte Dokument mit Ihrem Gebäudeplan. Als zweites öffnen Sie 
das Dokument mit den Objekten. Sollte das Dokument aus dem vorherigen Abschnitt noch offen 
sein, nehmen Sie dieses.

Beachten Sie gegebenenfalls die Hinweise auf den Betrieb mit mehreren Desktops von Seite 27. 
Bei einem ausreichend großen Bildschirm oder bei der Verwendung zweier Monitore können Sie 
die Dokumente auch nebeneinander positionieren.

Stellen Sie die Ansicht im Plan auf den Raum, den Sie als Schlafraum annehmen und zoomen Sie 
einen Ausschnitt.

Tipp

Sollten Sie eine Maus mit Scrollrad nutzen, dann wissen Sie sicherlich, das Sie im 
LibreOffice mit dem Scrollrad verschieben und zoomen können. Drehen Sie in Draw 
das Scrollrad11 und drücken Sie währenddessen eine der Tasten UMSCHALT, STRG 
oder ALT.

Schalten Sie nun zur Vorlage mit den Möbeln um. Markieren Sie eines oder mehrere Möbel und 
kopieren Sie diese in die Zwischenablage mit Bearbeiten > Kopieren (STRG+C). Im Anschluss 
wählen Sie das Dokument mit dem Plan aus und fügen den Inhalt der Zwischenablage über 
Bearbeiten > Einfügen (STRG+V) ein. Nun schieben Sie mit der Maus das Möbelstück an den 
vorgesehenen Platz.

Wiederholen Sie das mit allen Objekten, die Sie benötigen.

11 Scrollrad = Mausrad
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Zusammenstellung verschiedener Möbel 
in einer Bibliothek

Abbildung 23: Bett, Tisch und Küchenteile als Mustervorlage

Mit Hilfe solcher Bibliotheken (Abbildung 23) kann man eine ganze Einrichtung in einen Plan 
einfügen. Das eignet sich auch dazu, als Bauherr eine Einrichtung zu planen. Denn der Maßstab 
sorgt dafür, dass Sie sich nicht mit dem Platz verschätzen.

Hier beispielsweise eine Küche mit oben gezeigten Schränken (Abbildung 24).
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Abbildung 24: Plan für Küche und Schlafen

Installationssymbole einfügen

Auf die selbe Art und Weise mittels Copy & Paste fügt man Installationssymbole ein.

Aus einer (selbst erstellten) Bibliothek entnimmt man die entsprechenden Zeichen für Steckdosen, 
Schalter, Leuchten, Antennendose, Netzwerk oder Telefon.

Soweit sinnvoll, dafür immer in eigene Ebenen legen. Im folgenden noch einmal der gleiche 
Ausschnitt der Zeichnung, diesmal mit Installationssymbolen (Abbildung 25).

Abbildung 25: Installationssymbole
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Zu den hier gezeigten Symbolen gehört eine Bibliothek mit Elektrosymbolen, die ebenfalls schon 
in allen 4 Richtungen angeordnet sind (Abbildung 26).

Tipp

Sie können solche Bibliotheken auch anderen zur Verfügung stellen, damit nicht jeder 
"das Rad neu erfinden muss". Sie sollten dann die Bibliothek mit der gewünschten 
Lizenz versehen, und bei Nutzung das Copyright beachten. Mehr Informationen dazu 
erhalten Sie über die Mailinglisten discuss@de.libreoffice.org und 
users@de.libreoffice.org oder über unsere Webseite.

Bibliothek Elektro

Abbildung 26: Eine Bibliothek für Elektrosymbole

Solche Bibliotheken kann man sich kaufen oder selbst erstellen. Viele Schaltzeichen unterliegen 
allerdings nicht dem Copyright (Achtung, Bibliotheken aber sehr wohl!) und sind als gemein-freie 
Vektorgrafiken im Internet herunterzuladen.

Mit diese Symbolen, die oft im SVG Format vorliegen, kann man dann recht schnell ein Vorlagen-
Dokument wie oben erstellen.

Schauen Sie doch mal im Internet unter:
https://de.wikipedia.org/wiki/Liste_der_Schaltzeichen_(Elektrik/Elektronik) oder

http://commons.wikimedia.org/wiki/Category:Switch_symbols?uselang=de oder

https://wiki.documentfoundation.org/images/8/87/Installations-Schaltzeichen_DE.odg
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Weitere Informationen

Handbücher der LibreOffice Community

Die Handbücher für die einzelnen Anwendungen bestehen aus mehreren Kapiteln. Die Kapitel-
übersichten finden Sie auf der Webseite von LibreOffice - The Document Foundation

LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

LibreOffice Handbücher (englische Versionen) / 
https://wiki.documentfoundation.org/Documentation/Publications

LibreOffice bietet sechs Anwendungen (Komponenten) für die Erstellung und Bearbeitung
von Dokumenten und zur Datenverarbeitung:

• Writer - Textverarbeitung

• Calc - Tabellenkalkulation

• Impress - Präsentationen

• Draw - Zeichnungen

• Base - Datenbanken

• Math - Formeleditor

Die Kapitel

Jeder, der sich schnell mit LibreOffice vertraut machen möchte, wird die Kapitel zu schätzen 
wissen. Vielleicht sind Sie neu in der LibreOffice Suite oder Sie sind mit eine anderen Office-Suite 
vertraut. Die Kapitel von LibreOffice bieten Ihnen themengenaue Informationen.

PDF-Versionen

Alle Kapitel können frei als PDF-Version heruntergeladen werden:

LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

Die Autoren

Die Handbücher werden von Freiwilligen der LibreOffice-Community erstellt.

Über LibreOffice

LibreOffice ist eine leistungsfähige Office-Suite, für verbreitete Betriebssysteme wie Windows, 
GNU/Linux 32-/64-Bit und Apple Mac OS X geeignet.

LibreOffice entsteht aus der kreativen Zusammenarbeit von Entwicklern und der Gemeinschaft der 
Stiftung The Document Foundation / https://de.libreoffice.org/about-us/governance/. Die Stiftung 
hat ihren Sitz in Berlin / Deutschland.

Das Programm LibreOffice kann unter der Adresse LibreOffice Download / 
https://de.libreoffice.org/download/download/ kostenlos heruntergeladen werden.

Die Wiki-Seiten von LibreOffice

Sehr viele Informationen zu und um LibreOffice finden Sie auf den Wiki-Seiten.
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Kapitelübersicht - Draw Handbuch

Kapitel 1 - Einführung in Draw

Kapitel 2 - Zeichnen von Formen

Kapitel 3 - Arbeiten mit Objekten und Objektpunkten

Kapitel 4 - Objekteigenschaften ändern

Kapitel 5 - Arbeiten mit mehreren Objekten

Kapitel 6 - Bilder bearbeiten (Rasterbilder)

Kapitel 7 - Arbeiten mit 3D Objekten

Kapitel 8 - Verbinder, Fluss- und Organisationsdiagramme

Kapitel 9 - Text einfügen und formatieren

Kapitel 10 - Drucken, Exportieren, E-Mailen

Kapitel 11 - Fortgeschrittene Zeichentechniken

Anhang B - Optionen
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Hilfe

So verwenden Sie die Hilfe von LibreOffice.

Offline-Hilfe

Die Offline-Hilfe steht Ihnen nur zur Verfügung, wenn Sie sie auch installiert haben.

Platzieren Sie den Cursor an eine Stelle (Menü, Dialog etc.), an der Sie Hilfe benötigen.

Betätigen Sie die Taste F1, (bei Laptops evtl. FN+F1).

Online-Hilfe

Die Online-Hilfe wird Ihnen angeboten, wenn Sie keine Offline-Hilfe installiert haben.

Sie können die Online-Hilfe aber auch direkt in Ihrem Internetbrowser öffnen:

LibreOffice online Hilfe

Offline- und Online-Hilfe

Beide Hilfesysteme öffnen sich jeweils in Ihrem als Standard festgelegten Internetbrowser.

Im oberen Bereich befindet sich die Suchleiste. Dort können Sie Ihre Suchbegriffe eingeben. 
Schon bei der Eingabe eines Buchstabens bekommen Sie direkt darunter eine Auswahl von 
Themen. Mit jedem weiterem Buchstaben konkretisiert sich die Auswahl.

KLICKEN Sie dann in die Auswahl auf ein Thema, um die Beschreibung dazu im mittleren Bereich 
des Fenster zu lesen.

Noch Fragen?

Für Fragen zum Thema gehen Sie zu Ask.LibreOffice:

Fragen auf ask.LibreOffice

Mitarbeit bei LibreOffice

Besuchen Sie uns auch auf der Seite Dabei sein!:

LibreOffice Community

Spenden

LibreOffice ist freie Software und wird kostenfrei zur Verfügung gestellt. Ihre Spende, die rein 
freiwillig ist, unterstützt unsere weltweite Gemeinschaft. Wenn Ihnen die Software gefällt, freuen 
wir uns über eine Spende auf Spenden für die Document Foundation.
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Vereinbarung zwischen
Auftraggeber und Auftragnehmer

Haftungsausschluss

Die The Document Foundation TDF) und LibreOffice übernehmen keinerlei Haftung für 
die Richtigkeit oder Vollständigkeit der aufgeführten Angaben. Es wird keinerlei Haftung 
übernommen.

Mögliche Regeln und Vertragsvereinbarungen

In der Regel sind zwischen dem Auftraggeber (Bauträger) und dem Auftragnehmer 
(Elektro-Handwerksbetrieb) die Vergabe- und Vertragsordnung für Bauleistungen (VOB) 
vereinbart. Nach VOB C, DIN 18382:2002-12 Abs. 3.1.6 hat der Auftragnehmer (Elektro-
Handwerksbetrieb) alle für den sicheren und wirtschaftlichen Betrieb der Anlage 
erforderlichen Bedienungs- und Wartungsanleitungen und notwendigen Bestandspläne 
zu fertigen und dem Auftraggeber (zunächst dem Bauträger) diese und einzelne 
projektspezifische Daten zu übergeben (siehe auch VOB C, DIN 18382 Abs. 3.1.3)

So muss dem Bauträger u. a. auch ein revidierter Installationsplan ihrer Anlage 
vorliegen. Nach VOB C, DIN 18382 Abs. 3.1.7 hat der Auftragnehmer (Elektro-
Handwerksbetrieb), bevor die fertige Anlage in Betrieb genommen wird, eine Prüfung auf 
Betriebsfähigkeit und eine Prüfung nach den DIN-Normen (in der Regel bei 
Neuinstallationen nach DIN VDE 0100-610) auszuführen. Die Aufzeichnung der 
Prüfergebnisse und die Dokumentation sind vor Abnahme dem Auftraggeber (zunächst 
dem Bauträger) auszuhändigen. DIN VDE 0100-610 regelt hierbei die messtechnische 
Prüfung und Dokumentation einer jeden Neuanlage und ggf. auch der durchgeführten 
wesentlichen Änderung einer bestehenden Anlage. Nach DIN VDE 0100-610:2004-04 
Abs. 61.1.1 muss jede Anlage geprüft werden, bevor sie vom Benutzer in Betrieb 
genommen wird. Dies muss soweit sinnvoll, bereits während der Errichtung und / oder 
nach Fertigstellung erfolgen. Des weiteren muss nach Abs. 61.1.6 dieser Norm nach 
Beendigung der Prüfung ein Prüfprotokoll erstellt werden. Welche Prüfungen 
durchgeführt werden müssen, regelt Abs. 612 ff. derselben Norm. Es muss somit auch 
ein Mess- und Übergabeprotokoll seitens des Auftragnehmers (Elektro-
Handwerksbetriebs) beim Auftraggeber (Bauträger) vorliegen.

Zu einem bestimmten Zeitpunkt übergibt der Bauträger das Eigentum oder verkauft den 
Neubau an den Kunden und damit auch die neu errichtete elektrische Anlage, wodurch 
dieser zum Betreiber der elektrischen Anlage nach DIN VDE 0105-100 wird. Im Rahmen 
der Übergabe sind dem Betreiber der neu errichteten elektrischen Anlage sämtliche 
technischen Dokumentationen, Mess- und Übergabeprotokolle, die vom Grundsatz her 
erst einen sicheren Betrieb der neu errichteten elektrischen Anlage gewährleisten, 
unaufgefordert zu übergeben. Kommt der Bauträger dieser Pflicht nicht nach, so handelt 
er rechtswidrig, auch dann, wenn im Kaufvertrag zwischen dem Bauträger und dem 
Kunden keine VOB Teil C vereinbart wurde. Denn sowohl die in der VOB Teil C benannte 
DIN 18382 als auch die entsprechenden DIN-VDE-Normen zählen zu den allgemein 
anerkannten Regeln der Technik und besitzen Allgemeingültigkeit hinsichtlich des 
Nachweises des Grundsatzes eines sicheren Betriebs der neu errichteten elektrischen 
Anlage. Damit besitzen sie als allgemein anerkannte Regeln der Technik auch Gültigkeit 
im Rahmen beispielsweise eines BGB-Standardkaufvertrages. Einzige Ausnahme der 
dargestellten juristischen Kausalität stellt der Verkauf einer bestehenden elektrischen 
Altanlage dar. In diesem Zusammenhang sei vorbeugend jeder Bauträger ausdrücklich 
davor gewarnt, eine Neuanlage vor dem Verkauf als bestehende Altanlage zu 
deklarieren, denn auch der Begriff »bestehende Altanlage« wurde bereits in mehreren 
Grundsatzurteilen eindeutig definiert.
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Workaround zur Maßlinie

Der Grund für diesen Abschnitt ist ein vorhandener Fehler in der Funktion Maßlinie.

https://ask.libreoffice.org/t/draw-dimensioning-line-measurements/105255

Abbildung 27: Symbolleiste „Linien und Pfeile‟ 
– Symbol „Maßlinie‟

Zeichnen Sie nun eine waagerechte Maßlinie. Halten Sie die UMSCHALT-Taste beim Zeichnen 
gedrückt, um orthogonale Maßlinien zu zeichnen. Natürlich wird das Maß zunächst einmal nicht 
mit der Vorlage übereinstimmen. Sollte das Zeichenwerkzeug für Maßlinien nicht mehr aktiv sein, 
wählen Sie es erneut aus.

Workaround - Den Wert der Maßlinie ändern

Die Lösung aus dem verlinkten Fehlerbericht.

1. Stellen Sie sicher, dass Sie das gewünschte Maß vorher kennen. Und die Zoomstufe so 
gewählt ist, dass Sie die Maßlinie sauber an einem Ende beginnen können.

2. Starten Sie die Maßlinie genau an einem Ende mit KLICKEN-halten-ziehen, aber machen 
Sie sie mindestens so groß, dass die Maßzahl und die Einheit zwischen den Pfeilen passt 
(dies ist zunächst ein falscher Wert).

3. Wählen Sie bei ausgewählter Maßlinie im Menü Format > Position und Größe (F4).

4. Im Dialog Position und Größe geben Sie das Maß in das Feld Breite oder Höhe ein.

5. KLICKEN Sie auf OK .

Abbildung 28: Legende der Maßlinie

https://ask.libreoffice.org/t/draw-dimensioning-line-measurements/105255
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